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1. INTRODUCTION 

Thea for Rhino is an integrated plug-in that enables utilization of Thea Render rendering functionality 
within McNeel Rhino 5. 
 
The plugin enables wide range of features which include: 

 Biased/Unbiased/GPU render modes (utilizing CUDA technology) 

 Physically based material interface uniform of all render modes 

 Production render and fluid interactive render 

 Physically based environment (Sun/Sky) 

 Physically based cameras and lights using Thea for Rhino interface 
 
Note that this manual covers plug-in settings and options only, thus for a deeper and more detailed 
understanding of Thea Render features such as materials design, engines modes please obtain the 
Thea Render User Manual. 

2. APPLICATION PREREQUISITES 

Thea for Rhino requires an existing installation of McNeel Rhino 5 64bit edition and Thea Render Studio 
64bit to be available on your computer before executing the plugin installer. Installation of Thea Render 
Studio is necessary as major components of our renderer are provided by the main application. 
Currently the plugin is compatible for all 64bit Microsoft Windows operating systems from Vista 
onwards. 

2.1 Supported Rhino 5 features 

1. All Rhino models and blocks (instances/proxies) 
2. All Rhino lights 
3. Rhino Sun/Sky 
4. Rhino basic materials (materials are converted to Thea Render materials when render starts) 
5. Rhino Environment is not supported. Thea Environment has been integrated and should be 
used instead. 
6. Both production and interactive render inside the Darkroom are supported. 
7. During interactive rendering all scene change events are handled such as 
moving/adding/deleting objects and lights, material assignment to objects as well as showing/hiding 
objects and layers. 
8. Region render during interactive render. 
9. Network and bucket render. 
10. Rhino clipping planes. 
11. Import/export Thea models. 
 
Currently there are some features not supported but they are to be added in next releases. 
1. Bongo animation plug-in support. 

https://www.thearender.com/versions/TheaRenderManual_v1.4.pdf
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3. INSTALLATION 

To perform installation of Thea for Rhino plugin you 
will need to obtain the installer from our landing page: 

thearender.com/rhino 
 
Once executed the Rhino plugin installer will enquire 
about user access and therefore please make the 
appropriate selection depending on who you wish 
have to access to the plugin. The installer will then 
copy the appropriate files to the Rhino 5 plugin folder. 
 
Upon completion of the installation process you will 
need to start Rhino 5 and then from the Render Entry 
option from the Rhino Menu system you will need to 
assign Current Renderer to be Thea for Rhino. 

 

 

Troubleshooting: 
In the instance that Rhino 5 does not automatically 
load the TheaForRhino plugin steps you can perform 
manual installation by utilizing the Plugins window 
from the menu Tools→Options→Plug-ins. By 
selecting the ‘Install’ button you must navigate to the 
folder containing the TheaForRhino.rhp file. 
Installation folder is: 
 
C:\Users\[yourusername]\AppData\Roaming\McNee
l\Rhinoceros\5.0\Plug-ins” 
 
under a folder Thea for Rhino. 

 

 
 
 
 

Figure 1: Thea4Rhino Installation Window 

 
Figure 2: Rhino Plug-ins options window 

http://www.thearender.com/rhino
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4. LICENSING AND ACTIVATION 

If you have recently purchased Thea for Rhino bundle and have not performed the installation of Thea 
Render Studio, please visit our main download page - thearender.com/downloads - to obtain the latest 
installer for Thea Render Studio before proceeding with Thea for Rhino plugin installation and 
activation. 
 
Once Thea Render Studio has been installed you must input in the License Input Form the necessary 
information required to activate your Studio license. Select from Thea Render Studio application menu 
option Help – License Form and in the Main tab insert the license serial for Thea Studio along with 
your Full Name and Email (please note uppercase/lowercase information entry is important as your 
license key to the entered data). 
 
To complete the Thea Render Studio activation you need to select the Activate License button and 
then re-insert your Email per original data insertion. Please note that a live Internet connection is 
required as communication with the activation server is essential for successful activation of your 
license. 
 
Activation of your newly purchased Thea for Rhino plugin will allow you to enjoy full Thea Render 
functionality within Rhino 5. To perform activation of your plugin you must insert your Thea for Rhino 
plugin license key in the License Input Form – Plugins – Rhino Plugin option and press the Activate 
Plugin Licenses button (figure 4). 

  
 

Figure 3: License Input Form - Main Tab Figure 4: License Input Form, Plug-in Tab 

http://www.thearender.com/downloads
http://www.thearender.com/downloads
http://www.thearender.com/downloads
http://www.thearender.com/downloads
http://www.thearender.com/downloads
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5. GETTING STARTED – MAIN WINDOWS 

All Thea for Rhino plugin functionality can be explored through the Thea Render menu bar as well as the 
Thea Render toolbar within Rhino 5. Thea materials can be created in the Rhino material section. Also 
Sun/Sky can be edited in the Rhino Sun/Sky section. The Thea Render menu is the main entry point for 
Thea for Rhino features. Darkroom, render settings, import/export as well as the license form are the 
available options of the plugin menu. All these options are explained in the upcoming sections. 

5.1 Thea Render Toolbar 

Our toolbar provides easy and efficient access to Thea for Rhino features. It provides the Thea for Rhino 
commands alone or combined, as well as Rhino commands making the desired and required features 
centralized. Figure 5 below provides an overview of available toolbar icons: 
 

 

Opens the Darkroom window. This is where rendering takes place and is explained in section 
5.2. 

 

Opens the Render Settings dockable window. It is explained in section 5.3 

 

Opens the Rhino material editor and creates a new Thea material. This button is a 
combination of multiple commands that eases the creation of Thea materials (section 5.4). 

 

Opens the Rhino Sun/Sky window. 

 

Imports a Thea model (mod.thea). 

 

Imports a Thea environment file (sky.thea). 

 

Imports render settings from a file. 

 

Exports a Thea model (mod.thea). 

 

Exports the Thea environment. 

 

Exports the render settings. 

 

Exports the whole scene (scn.thea, pack.thea). 
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5.2 Thea Render Darkroom 

Thea Render Darkroom provides access to all our production and interactive render modes within Rhino 
5. Within this environment you have full access of display variables such as ISO exposure, shutter speed, 
f-number and many more. 
 
Thea Render Darkroom has been divided into four major sections. The top section of the Darkroom panel 
provides basic render controls as well as the interactive render controls. Render images       are provided 
in the center panel while render controls and display controls are at the bottom. 
 

 

Figure 6: The Darkroom. The place where rendering takes place 
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5.2.1 Interactive Render Controls 

 
This part of the Darkroom contains some basic render and interactive render controls. 
 

 

This is a combo box which can switch from production to interactive render mode and 
vice versa. Production render mode renders the scene without adjusting it when a 
change in Rhino occurs. Interactive mode responds to every change in the scene 
immediately. 

 

This combo box selects the render engine to be used in production or interactive mode. 
Interactive mode supports the Presto AO, Presto MC as well as Adaptive AMC. 
Production mode supports also Unbiased TR1, Unbiased TR2 and Adaptive BSD. 

 

This combo box controls the render resolution. The default value is set to follow the 
Thea camera resolution as set in the interface (section 5.3.3). Also the Rhino viewport 
resolution can be set as well as some other resolution presets. 

 The lock viewport control can be used during interactive rendering only. When 
checked, it “locks” the active Rhino viewport and only this one is used in rendering. 
Other Rhino viewports can be enabled without changing the active Thea camera in 
rendering. 

 Those two controls enable and handle region render during interactive rendering. The 
first control is a button which enables drawing a rectangle on the Darkroom to define 
the region. The second control is a combo box containing all the regions selected for a 
particular Rhino view and helps enabling different regions without the need to define 
them again. 

  
The last six controls can be used during interactive rendering only. The controls that edit the active Thea 
camera, also update the Rhino viewport. 
 

 

When enabled, the interactive “pick focus distance” action gets enabled. By clicking on the 
rendered image, camera focus distance is adjusted accordingly. 

 

Camera rotation. By holding the left mouse button and moving the mouse on the rendered 
image, the camera is rotated. 

 

Camera pan. By holding the left mouse button and moving the mouse on the rendered 
image, the camera is panned. 

Figure 7: The top part of the Darkroom. Controls for basic render settings as well as interactive 
rendering controls 
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Dolly. Using the mouse wheel on the rendered image, the camera is zoomed in/out. 

 
Camera roll. Using the mouse wheel, the active camera is rolled. 

 Pick material. Left clicking on the rendered image, the material assigned to the object under 
the cursor is selected on the Rhino material section. Materials assigned to objects must be 
of type “Thea Material”. 

 

5.2.2 Production and Interactive Render 

This part of the Darkroom controls both the interactive and production render process. Below these 
controls are explained from left to right order. 
1. Save the rendered image. Many image formats are supported such as PNG or EXR. 
2. Shows the elapsed time during production rendering. 
3. Refreshes the rendered image. This is particularly important because if the rendering has  stopped 
and the display settings have changed, this control will update the rendered image. 
4. Provides feedback about the render status. 
5. Starts rendering. Production or interactive render get started depending on the selection of the 
render mode. 
6. Pause rendering. It is applicable only during production rendering. When render is paused, the 
only action that can be performed is resume render (the start button). 
7. Progress percentage feedback. 
8. Stops both production and interactive render. 

 
 

5.2.3 Display Settings 

The controls shown below, affect the display settings of the camera. They are very important because 
when used along with the camera settings, they can improve dramatically the rendered image. Also the 
channel combo box can show the image in a different channel if this channel was selected before render 
started. For a complete explanation, please consult the section 5.4 of Thea Render manual. 

 

Figure 8: The Darkroom controls that controls rendering 

 

Figure 9: The Darkroom display controls 

https://www.thearender.com/versions/TheaRenderManual_v1.4.pdf
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5.2.4 Network Rendering 

Network rendering gives the ability to allow multiple computers to contribute to the rendering process. 
Network rendering can be enabled in the Distribution section of Rendering tab in Thea Render settings 
(section 5.3.1). Darkroom has the Network Log page which displays information during network 
rendering. The name, IP address and contribution of the clients are depicted on this page. 
 

 

Figure 10: Network log page 

 

 

 

 

 

 

 

 

 

 

5.3 Thea Render Settings 

The render settings dialog can be opened both from the Thea Render menu as a separate dockable 
window or by right clicking on a dockable window in Rhino and selecting the Thea Render entry. 
This window consists of three tabs, the rendering, the environment and the camera. 
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5.3.1 Thea Render – Rendering 

The Rendering tab has all the options needed to set the render 
engine and its properties. It consists of many expanding sections 
which are collapsed/expanded when clicked on the header. This 
helps to isolate the desired render settings and not get distracted 
by others. 
The main section is the most important one. Render mode, 
render engine and some basic options can be set. 
Four types of render engines are supported; Biased, Unbiased, 
Presto and Progressive. 
 
• Biased (Adaptive BSD): Can only be used for production 
render and is based on field mapping and final gathering. 
• Unbiased (TR1/TR2): Those two engines can be used in 
production mode. They can be used to effectively solve difficult 
lighting and they are very easy to set up. 
• Presto (MC/AO): Presto AO and Presto MC engines can be 
used for both production and interactive rendering. They are 
mostly used for direct lighting. 
• Progressive (AMC): It can be used both in production and 
interactive rendering. This particular engine uses the logic of an 
ubiased engine with some extra performance 
 
Under the Distribution section, the number of CPU threads can 
be set as well as the network rendering option. By enabling the 
Network Rendering check box, the plug-in runs in server mode 
and Thea clients can be connected and contribute to the render 
process. 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11: The rendering settings 
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5.3.2 Thea Render – Environment 

The Environment tab provides controls the environment of a 
scene. The Rhino environment is not supported. Environment 
must be set from the Thea Render settings dialog. In this tab 
you can see the settings supported by Thea Render 
distinguished in expanding sections. 
 
The Sun as well as the Sky can be enabled and set in the Rhino 
sun section which is located in Render→Panels→Sun (Or you 
can use the corresponding button in the Thea Render toolbar). 
1. Physical Sky 
• Turbidity is a term used to describe the scattering of 
the atmosphere that is caused by haze. The term haze refers 
to an atmosphere that scatters more than molecules alone, 
but less than fog. Haze is often referred to as a haze aerosol 
because the extra scattering is due to particles suspended in 
the molecular gas. Because the haze particles typically scatter 
more uniformly than molecules for all wavelengths, haze 
causes a whitening of the sky. The actual particles come from 
many sources such as volcanic eruptions, forest fires, cosmic 
bombardment, the oceans etc. 
• Ozone defines the amount of ozone gas in the 
atmosphere. The standard way to determine the amount of 
total ozone is by measuring the amount of ozone gas in a 
column of air and is expressed in Dobson units. One Dobson 
unit indicates 0.01 millimeter thickness of ozone gas in a 
column. The default value in Thea is 0.350 cm. Higher values 
give the sky and the scene a blue color. 
• User can define here the amount of water vapor in the 
atmosphere. In the same way as ozone, it is measured in 
centimeters. 
• Turbidity coefficient is the power for exponential 
transmittance for atmospheric aerosol. 
• At this point the wavelength exponent can be defined. 
The default value is set to 1.3. This number shows the average 
size of the particles in the atmosphere. 
• Albedo option can influence the overall appearance of 
the sky. High albedo values can occur for example in winter 
scenes by the snow reflectance while small values occur at 
environment with grass. Especially in cases with high turbidity 
settings, changing the albedo value changes the overall 
brightness of the sky. 
•   

Figure 12: Thea Render Environment 
settings 
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2. Image Based Lighting 
It enables an image for lighting the scene instead of the Sun. Notice that when IBL is enabled, sun get 
disabled and vice-versa. Wrapping and rotation are related to the image's position. This image is also 
used at the background. 
3. Background Mapping adds an image to the background of the scene. 
4. Reflection Mapping adds an image for the reflection of the objects. If we do not enable this 
option, reflections are according to the map inserted at the IBL panel. Note: for materials that their 
roughness is close to zero (or zero), the reflection is based totally on the Reflection Mapping. Though, for 
higher values, there is an interpolation between this image and the IBL image. 
5. Refraction Mapping is similar to the Reflection mapping but it affects the refraction of the objects. 
6.  

5.3.3 Thea Render – Camera 

The last tab contains the settings for the Thea camera. 
The camera settings might be different than the Rhino 
viewport settings. 
 
Focal length and projection do communicate with the 
Rhino viewport but resolution does not. 
 
This way, you might have a small resolution set in Rhino 
viewport but render images in higher resolution. 
 
Different camera settings are stored for different Rhino 
viewports. When setting a Rhino viewport as active, the 
camera settings are updated accordingly. 
 

 
Figure 13: Thea Render camera settings 
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• Film section contains the resolution, film height and focal length settings of the camera. The “Sync 
with Rhino viewport” button is a fast way to set the Rhino viewport resolution to the Thea camera. The 
focal length corresponds to the distance of the camera lens to the film. 
• The lens section contains the properties of the camera lens. These are the projection, shutter 
speed, shift X/Y, diaphragm and blades. 
• The depth of field options adjust the camera focus. When the f-number value is 0 it corresponds 
to pinhole. The focus distance value is the distance the camera is focused on. Objects far from this 
distance are rendered blurred. Focus distance can be set both by entering the distance value and by 
clicking on the “Pick...” button and select an object on the Rhino viewport. 
• Z-Clipping offers the choice to the user to clip certain portion of the render based on the far and 
near distance of the camera. 

 

5.4 Thea Lights 

Thea light properties can be configured from a separate dialog. 
When a light is clicked in the Rhino viewport, the Thea light 
properties page is shown in the properties page. Depending on 
the light type, the appropriate controls are shown. 
 
Light properties are divided in two categories which are General 
and Emittance properties. 
 
The Emittance properties set the color, power, units, efficacy and 
the attenuation. The physically based value of the attenuation is 
inverse square which means that the light energy is decrease by 
the square distance of the light to the objects. Rhino spotlights 
are converted to Thea spot lights. Spot lights have also the 
property of setting the angles of both the hot spot (light beam 
has constant power) and fall off (maximum angle after which 
light is not emitted at all). 

 

 

Figure 14: Thea Light Editor 
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5.5 Object properties 

Thea for Rhino attaches some Thea properties to Rhino models. 
Those attributes can be configured in the Thea object properties 
page. The parameters with the blue label are only taken into 
account when Adaptive BSD engine is used. What is more, 
disabled means that the object becomes invisible and its 
properties (shadow caster, emitter material) become disabled. 
Visible/Invisible means that only visibility changes but the 
properties might be enabled (e.g. invisible emitter). Mask index 
is used in the Mask channel production. Objects with mask index 
greater than zero, will make Thea for Rhino to produce a separate 
channel for them when Mask channel is enabled. 

 

Figure 15: Thea object properties page 

 

 

 

 

 

 

 

 

 

 

5.6 Thea Render Materials 

Thea Render materials creation is performed in the same fashion as Rhino 5 materials. When clicking on 
the Add New Material icon (Figure 14), a Thea material must be chosen. After the Thea material is created 
the material editor is shown. The material editor is separated is two parts. First part provides settings for 
the material preview while the second is used to edit a material. 
 
 
There are three ways to manage material within the user interface: 
1. Import an installed material from the material browser 
2. Choose a material preset 
3. Edit it in the Thea MatLab 
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5.6.1 Thea Material Preview 

The preview settings panel affects the preview 
thumbnail from the material list. 
The room is an installed scene that is opened to 
render the material. Other rooms are installed like 
the direct, cloth etc. Each material can be set to be 
rendered in different room. 
The threads edit set the number of CPU threads to 
be used for the preview rendering. Default Zero 
(0) value assigns maximum processor threads, 
thus full CPU capability. 
Custom visualisation in the Rhino viewport can be 
achieved through the Rhino viewport visualization 

 

Figure 14: Creating a new Thea Material 

 

Figure 2 

 

Figure 3 

 

Figure 4 

 

Figure 15: Thea Render Material editor panel 

 

Figure 16: Thea Material preview settings 
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properties. The active BSDF layer can be selected, 
if multiple exist, and then, the diffuse and 
reflection colors in the Rhino viewport can be set 
with the ones from the selected BSDF layer.  

5.6.2 Browser  

Thea Studio comes with a set of materials. The 
first button in the material editor of Thea for Rhino 
opens a material browser. This browser shows all 
the materials that were installed with Thea Studio. 
On the left there is a list of material types and 
when selected, the materials of this type are 
shown on the right. Custom folders can be added 
in the browser by right-clicking on the Custom 
Folders entry. 

 

5.6.3 Material Panel - Editor 

The editor section of the Thea Material Panel 
provides abstracts all the details of Thea Render 
physically based materials and provides the user 
with a set of predefined presets leaving the option 
for users wanting to explore and use the physically 
based Thea material system. 
 
 

 

The first button opens the material browser that explained above. The next button is a combo box with 
the material presets. When a preset is selected from the combo box list, this kind of material is created 
and the available edit options are shown below. Figure 14 shows the editor when a Plastic material has 
been created. Color or a texture can be set for the material's color, reflection and roughness percentage 
can be set and finally a bump texture can be added on this material. Furthermore, materials can be saved 
as plain material files (mat.thea) or as packed material files (mat.pack) which will add all the textures in 
a single file. 
The last button opens the Thea MatLab as an external application. 

 

Figure 17: Material browser 

 
Figure 18: Material editor 
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5.7 Import/Export 

Import and Export can be accessed through the Thea Render menu. Environment, Thea models and 
render settings can be imported in Rhino. In the export entry, Thea models, environment, render settings   
or the whole Rhino scene converted to Thea can be exported. 

5.7.1 Thea models 

Thea models (.mod.thea files) can be imported in Rhino. They are imported as blocks and thus, many 
copies of them can exist without increasing the scene size. When importing Thea models, the Thea 
content browser opens listing the installed Thea model libraries. When exporting Thea models, the first 
step is to select the Rhino objects (if multiple objects are selected they will be grouped), then provide an 
image for the preview and finally save the Thea model. 
 

 

Figure 19: Importing Thea models. 

5.7.2 Environment 

Thea environment (sky.thea) can be imported as well. The Thea content browser opens pointing to the 
installed environment libraries.  
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Figure 20: Importing Thea environment. 

5.8. Changing the Texture paths 

By going to the Thea Render→Misc→Change Texture Paths or running the TheaChangeTexturePaths a 
window is popped up to select a folder. After selecting the folder, all the texture paths from the materials 
as well as the environment point to the new folder. 

6.0 Preferences 

Some specific options can be set through the Preferences window. This window can be opened via the 
Thea Render menu. It consists of two pages, the General options and the EXR options. 
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6.0.1 General 

In the general page, the default paths of saving rendered image, IES files and render settings files can be 
configured. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 21: General settings. 

6.0.2 EXR 

In the EXR page, the multi-layered EXR settings can be set. 
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Figure 22: EXR settings. 

7.0 Update 

By selecting “Update” from the Thea Render menu (or typing TheaUpdate in the Rhino console) the 
update window pops up. From there, you can check for new Thea versions and resource libraries and 
download them. 
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Figure 23: Thea Render update. 

 


